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WILO Mather and Platt Pumps Pvt. Ltd.

Pune Works

Mumbai Pune Road,
Chinchwad, Pune — 411 019.
Maharashtra (India)
T+9120 27442100

Kolhapur Works
GokulShirgaon, MIDC,
Kolhapur - 416 234.
Maharashtra (India)
T+91 2312672904
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Sales and Marketing Office
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Who we are

Foundedin 1872 as Kupfer- und Messingwarenfabrik in Dortmund, Wilo has evolved from being a local specialist to a global player. As the
majority shareholderwith a stake of approximately 90 percent, the Caspar Ludwig Opldnder Founded ensures the company’s continuity and
independence. An uncompromising customer-driven mind-set, immediate market proximity and, in particular, our culture of innovation
have made us who we are: one of the worldwide leading manufactures of high-tech pumps and pump systems.

What we are

Wilo is a premium supplierin the field of building services, water management and industry. This leading position drives us to maintain our
superiority. For our customers, we make complex technologies user-friendly, simple to operatem energy-efficient and powerful. The main
focus of ouractivitiesis therefore onthe people. We offerthem outstanding products, system solutions and services. In this spirit, our brand
promise “Pioneering for You” stands for maximum quality of life.
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- Building Services

In order to maximise the efficiency of
buildings, it is becoming increasingly
important to use innovative and
energy-saving systems incorporating
components that are optimally matched
to one another. This applies to detached
and semi-detached houses, public
buildings, industrial buildings, office
buildings, hospitals and hotels: Wilo
offers energy—effluent solutions for
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intoa global chalfenge-Wilo-offers
profeSsional solutions designed-to
meet-the complex requirements
involved.in-theproduction-of potable

~-water, water purification, water

pumping, water treatment and waste-
water disposal. Wilo-water management
pumps and systems.set benchmarks

in the areas of technical performance,

' effici'ency and sustainability.
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WILO Mather and Platt Pumps Pvt. Ltd.

Mather and Platt started its Indian operations in 1913 from Kolkata, and has been fulfilling
the need of water supply for more than 100 years in India for segments like building
services, water management and industries.

Company started its manufacturing operations at Chinchwad, Pune in the state of
Maharashtra, in the year 1959.

The company manufactures various types of large size centrifugal pumps and pumping
systems at its Chinchwad plant.

Mather and Platt Pumps Ltd. become a part of WILO SE in the year 2005
In the year 2009 a new state of art manufacturing facility covering over approx. 6000 sq.

meters has been built at Kolhapur around 260 km from Pune to manufacture the latest
high efficiency pumps and pumping systems in India.

1890 1940 1978

Mather+Platt became
Indian Company ACP Kolkata

Mather+Platt First Factory
entered India started in Kolkata

1870 1913 1959
First Pump built by Mather+Platt Second Factory

Mather+Platt operations started in started in Pune
India
1872
Wilo was
founded
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The Pune & Kolhapur plants have acquired 1ISO 9001, ISO 14001
and OSHAS 18001 and the products are CE certified.

In recent past we were the pioneers in manufacturing one of the
India's largest metallic vertical turbine pump supplied with more
than 4 MW motor.

A Green feather in the cap.....
Our Kolhapur plant is
Council (IGBC).

by the Indian Green Building

In the year 2014 the status of the company changed from public
limited to private limited and the name of the company is changed
to WILO Mather and Platt Pumps Pvt. Ltd.

2007 2011
Mather + Platt aquired State-of-the-art
manufacturing facility
inagurated at Kolhapur

2005 2009
Aquired by Manufactured
WILO SE, Germany largest metallic pump

with 4 MW motor
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Chinchwad Plant
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Water is life.
And since 1872, Wilo has been connecting
people with water.
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Wilo - Dry Rotor Pumps

Product End Suction Back Pull Out Pumps Vertical Inline Pumps Horizontal Split Case Pump

MISO/NL/PISO IL/APL/DL/PIL SCP/ST/SN/LONO/LE/ME/ASP
Range Flow upto: 750 m*/hr Flow upto: 800 m*/hr Flow upto: 18000 m*/hr

Head upto: 170 m Head upto: 110 m Head upto: 270 m

Temperature: up to 120°C Temperature: up to 140 °C Temperature: up to 120°C

Delivery size: DN 32 - DN 150 Delivery Size: DN 32 - DN 250 Delivery Size: DN 32 - DN 1200
Product/ > Conformsto SO 2858 & EN 733 > Available with IE2 motor > Single/double suction impellers
Design > Back pull out design > Mechanical seal as a standard > Grease/oil lubricated antifriction
Eeatines > Closed/semi open impellers > Flameproof motor (optional) bearings.

> Grease/oil lubricated antifriction > Mechanical seal/gland packing

bearings

> Mechanical seal/gland packing
Material of > Casing: Cast iron/SS/NiCi/WCB > Casing: Cast iron > Casing: Cast iron/SS/NiCi/WCB
Construction > Impeller: Cast iron/Bronze/SS/ > Impeller: Cast iron/bronze > Impeller: Cast iron/Bronze/SS/

NiCi/wcB NiCi/wcB

Applications > HVAC systems > HVAC systems > HVAC systems

> Water transfer > Water transfer > Water transfer

- Distribution systems - Distribution systems - Distribution systems

> Fire fighting > Cooling tower > Fire fighting

> Cooling tower > Cooling tower

BSC Brochure

Wilo - Multi Pump Pressure Boosting System
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Product CO - X XXX BC/EC €O (R) = X XXx/cc COR - X XXX/VR
WMP BOOST-X XXX PC-C WMP BOOST-X XXX PC-SV WMP BOOST-X XXX PC-MV
Flow upto: 400 m’/hr Flow upto: 800 m’/hr Flow upto: 400 m’/hr
Range P / P /h P /h
Head upto: 110 m Head upto: 200 m Head upto: 200 m
Temperature: up to 70°C Temperature: up to 70°C Temperature: up to 70°C
Delivery size: DN 32 - DN 200 Delivery size: DN 32 - DN 200 Delivery size: DN 32 - DN 200
No of pumps — 2 to &4 No of pumps — 2to 8 No of pumps — 2 to 4
Product/ - Indication lights > PLC Based system (CO) and with > Control panel with individual VFD for
Design > Cascading, altering function single VFD (COR) each pump
Features - Overload protection > HMIl touch screen > LCD with back lit display
> Main Switch with door interlock - Multi colour display > BMS compatibility
> Adjustable timer for run/stop > Three stage security password -> Internal circuit breaker with door
pumps - Alphanumeric error message interlock
Dry run protection with capacity of 35 messages > Each pump operation status
> Factory made systems > BMS compatibility > Password protection facility
> Pump test run facility > On screen menu driven functions
-> Factory made systems with rotary switch
> Factory made systems
Material of > Pumps with SS 304 internals > Pumps with SS 304 internals > Pumps with SS 304 internals
Construction > Manifolds, base frame — Gl > Manifolds, base frame — Gl > Manifolds, base frame - Gl
> Other material of construction > Other material of construction - Other material of construction
available on request available on request available on request
Applications - Pressure boosting - Pressure boosting > Pressure boosting
> Tank filling > Tank filling > Tank filling
> Water transfer > Water transfer > Water transfer
> Gardening
Options > With complete SS 304 monobloc > With complete SS 304 monobloc > With vertical multistage pumps in
Available pumps pumps SS 316L and SS grade of manifolds
> With vertical inline multistage > With vertical multistage pumps in > BMS compatibility with
pumps SS 316L and SS grade of manifolds Communication system
-~ BMS compatibility with

Communication system
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Quality.
This is what matters.
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Wilo - Submersible Drainage and Sewage Pumps
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Product Submersible Dewatering Pumps Submersible Sewage Pumps Submersible Cutter Pumps
FAS/MPDP/CP/DP/KS/TS/FAC-H TC/STS/FAC/TP/FA/MPSP/FAC-H MTS/MTC
Range Flow upto: 340 m’/hr Flow upto: 8000 m’/hr Flow upto: 19 m’/hr
Head upto: 68 m Head upto: 100 m Head upto: 56 m
Temperature: up to 95°C Temperature: up to 60 °C Temperature: up to 70°C
Delivery size: DN 32 - DN 100 Delivery size: DN 32 - DN 600 Delivery size: DN 32 - DN 40
Passage size: up to 25 mm Passage size: up to 200 mm
Product/ > Available in single & three phase > Available in single & three phase - Available in single & Three Phase
Design > Stationary/portable installation > Stationary/portable installation > Stationary/portable installation
ERRrare. > With/without agitator > With/without agitator > Inbuilt level sensor
> Inbuilt level sensor > Inbuilt level sensor > Flameproof motor (optional)
> Wet pit/dry pit installation - Flameproof motor (optional)
- Flameproof motor (optional)
Material of > Casing: Cast iron/SS/polyurethan > Casing: Cast iron/SS/polyurethan > Casing: Castiron

Construction

> Impeller: Cast iron/SS/
polyurethane

> Impeller: Cast iron/SS/
polyurethane

> Impeller: Castiron

Applications

> Basement dewatering
> Dewatering at construction sites
> Treated effluent transfer

> Sewage transfer
Sewage effluent transfer
> Sewage treatment plants

v

Kitchen sewage

Hospital waste water
Sewage transfer

Sewage effluent transfer

vy v
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Wilo - Fire Fighting Sets

Product Multistage pumps Multistage multi outlet pumps
Flow upto: 1000 m*/hr Flow upto: 1000 m*/hr
Range W up / wup /
Head upto: 1500 m Head upto: 1500 m
Temperature: up to 160°C Temperature: up to 160 °C
Delivery size: DN 32 - DN 250 Delivery size: DN 32 - DN 250
Product/ > Stages:3to15 > Stages:3to15
Design - Radial flow impellers with vane - Multi outlet design
Features diffusers - Radial flow impellers with vane

> Mechanical seal/gland packing
- Grease lubricated anti-friction
bearings

diffusers
> Mechanical seal/gland packing

> Grease lubricated anti-friction
bearings

Material of

> Casing: Cast iron/SS/NiCi/WCB

> Casing: Cast iron/SS/NiCi/WCB

Construction > Impeller: Cast iron/Bronze/SS/ > Impeller: Cast iron/Bronze/SS/
NiCi/WCB NiCi/wcB
Applications > Fire fighting for high rise buildings > Fire fighting for high rise buildings

> Pressure boosting
> Water transfer

Electric Motor Driven Sets

End suction, horizontal split case,
multistage-single/ multi outlet
pumps with electric motor.

> Enclosure-TEFC/SPDP
> Voltage - 415V
> Frequency - 50 Hz

Diesel Engine Driven Sets

End suction, horizontal split case,
multistage-single/ multi outlet
pumps with radiator cooled and
heat exchanger cooled diesel
engine.

Accessories (On request):

- Control panel

> Fueltank

> Battery

> Battery cable

Jockey Pump

End suction and vertical inline
multistage pumps with electric
motor.

> Enclosure-TEFC/SPDP

> Voltage-415V

-~ Frequency-50 Hz
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Product Vertical Inline Multistage Pumps Vertical Inline Multistage Pumps Horizontal Monobloc
MVI Helix (SS Version)
Range Flow upto: 140 m’/hr Flow upto: 85 m’/hr Flow upto: 24 m’/hr
Head upto: 220 m Head upto: 240 m Head upto: 65 m
Temperature: up to 120°C Temperature: up to 120°C Temperature: up to 110°C
Delivery size: DN 25 - DN 100 Delivery size: DN 25 - DN 80 Delivery size: DN 25 - DN 40
Product Self Priming Monobloc Pumps Non Self Priming Monobloc Pumps Open Well Submersible Pumps
Range Flow upto: 5 m’/hr Flow upto: 110 m’/hr Flow upto: 88 m’/hr
Head upto: 50 m Head upto: 80 m Head upto: 62 m
Temperature: up to 40°C Temperature: up to 60°C Temperature: up to 40°C
Delivery size: DN 40 - DN 80 Delivery size: DN 40 - DN 80
Product Single Pump Booster Circulators Bore Well Pumps (SS Version)
Range Flow upto: 13 m’/hr Flow upto: 100 m’/hr Flow upto: 130 m’/hr

Head upto: 65 m

Head upto: 18 m

Head upto: 420 m

Temperature: up to 60°C

Temperature: up to 110°C

Temperature: up to 40°C

Delivery size: DN 25 - DN 40

Delivery size: DN 32 - DN 150
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High Efficiency

Water supply.
Why big ideas need pressure

CCS HVAC Controller
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VR HVAC Controller

Variable speed Pump Control unit for HVAC System.

Wilo Mather and Platt Pumps Pvt. Ltd. CCS HVAC (Comfort Controller HVAC)
controller is based on state-of-the-art-technology with flexibility o meet the
current and future customer requirements. The CCS HVAC Controlleris specially
designed for automatic control for pumps in parallel, integrated with Variable
frequency drives in duty as well stand by opertion in heating ventilation and air
conditioning application. The CCS HVAC controller is equipped with a multi
color, wide screen, user friendly touch screen with HMI (Human machine
interface) which offers a very simplified control and input unit, menu navigation
foreasy operation and control.

The CCS HVAC Controller operates the pumps to meet the changing system
demand received by the sensors by varying the speed of the pumps to meet the
systemrequirementandresultingin energy saving operation.

Standard Features

> Wall Mounted/Floor Mounted Enclosure

Internal Circuit breaker with door interlock

System can control 1 - 6 pumps, extendable up to 8 Pumps

Microprocessor based pump logic controller.In built PID with
auto/manual tuning

Embedded logic to prevent pump hunting, pump flow surges and
motor overheating

Multi color, wide screen (5.6”), High resolution HMI with 24VDC
power supply

On screen menu driven functions

Manual and Automatic System control (Man-off-Auto)
Multi level user password security

Alpha Numerical Alarm and Fault data login

Remote start/stop mode - Real time Clock

End Of curve protection - 3 Different set points
Each Pump operational data - Remote set point

Set value VS process value Graph

Sensor operation mode selection i.e. Max, Min, Avg, or Most
deviated

Communication ports RS232, 2xRS 485, 2xUSB

Each VFD data read out on screen

Supports Mod Bus RTU Protocol

Controllers available with VFD’s, with/without bypass starter and single/
multiple DPT’s. VFD inside the enclosure with/without bypass starter and
single/multiple DPT’s. Customised panels on request.

- Analogue inputs for Remote set point, Differential pressure sensors

and Flow

2 vy
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Optional Features
- Encl with or without provision for VFD

- BACNET, Ethernet TCP/IP and other communications protocol
modules on request

Dimensional Data
> Size(inmm) : 500hx500wx250d
- Approximate Weight : 30Kgs

Variable speed Pump Control unit for HVAC System.

WILO Mather and Platt Pumps Pvt. Ltd., VR HVAC Controlleris specially designed
for automatic control of pumps in heating, ventilation and air conditioning
applications. The VRHVAC controller is used along with Variable frequency
drives and Differential transmitter to control the differential pressure in a
system as a function of the load. VR HAVC controller offeres a simplified control
and easy of operation. The VR HVAC Controller operates the pumps to meet the
changing system demand received by the senors by varying the speed of the
pumps to meet the system requirements and resulting in energy saving
operation.

Standard Features

Wall Mounted/Floor Mounted Enclosure.
Internal Circuit breaker with door interlock.
System can control 1-4 pumps max.
Automatic pump alteration.

Duty and standby selection of the pump.

Microprocessor based pump logic controller with
built in PID.

Control Modes Delta PC and Delta PV.

Embedded logic to prevent pump hunting, pump
flow surges and motor overheating.

LCD with Back-lit Display.

On screen menu driven functions with rotary
switch.

Emergency operation mode.
Password protection for security.
Alarm and Fault data login.

Common Failure and Operation relays.
Remote start/stop mode.

Analogue inputs for Remote set point.
Each Pump operational data.

N N N 2NN
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Optional Features.
- Encl with or without provision for VFD.

- Communication ports to receive data from Variable
frequency drive.

Dimensional Data
> Size (in mm) : 500hx500wx250d
- Approximate Weight ~ : 30Kgs.
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References References

Supply:

7 Nos pressure boosting system

12 Nos dewatering/ sewage submersible pumps
6 Nos control panels for dewatering/ sewage
submersible pumps

24 Nos HVAC pumpsets

4 Nos Fire fighting pumps sets

Client:

Seven Hills Hospital, Mumbai

Olympic Stadium,
Kiev, Ukraine, Europe

Supply:

HVAC

10 Nos pump sets for primary pumping

6 Nos pump sets and control panels

for secondary pumping

FIRE

10 Nos pump sets for condenser pumping

11 Nos fire fighting sets along with jockey pump
Client:

Amanora Park Town Mall, Pune

LEEA
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The Hague City Hall,
The Hague, Netherlands, Europe
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Supply:
6 Nos pressure boosting systems
22 Nos dewatering/ sewage submersible pumps

11 Nos control panels for dewatering/ sewage
submersible pumps

Client:
Hotel Sofitel, Mumbai

Shopping center GIPPO,
Minsk, Belarus, Europe

Supply:

3 Nos Multistage Multioutlet

Fire fighting Pumpsets

Client:

The Grand Central (ITC Hotel), Mumbai

The Place, Beijing,
Beijing, China, Asia
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